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LICENSE AGREEMENT FOR ZIFF-DAVIS' WINSTONE® 
96 VERSION 1.0
READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE EMBODIED IN THE WINSTONE® 96 VERSION 1.0 CD-
ROM OR, IF PRELOADED ON YOUR HARD DISK, DOWNLOADED OR IF PROVIDED AS PART OF A COLLECTION, THE 
PRELOADED, DOWNLOADED OR COLLECTED FILE(S) (the "Media"). Embodied in the Winstone 96 Media is the Winstone 96 computer 
program and related documentation (the "Winstone 96 Program") and application programs and related documentation (the "Application 
Programs"). The Winstone 96 Program and the Application Programs are collectively referred to herein as the "Software." Ziff-Davis Publishing 
Company, having a place of business at One Park Avenue, New York, New York 10016 ("Ziff-Davis") is the licensor under this Agreement and 
you are the licensee. By using the Software, in whole or in part, you agree to be bound by the terms of this Agreement. If you do not agree to the 
terms of this Agreement, promptly return the Software to the Ziff-Davis Benchmark Operation at 1001 Aviation Parkway, Suite 400, Morrisville, 
North Carolina 27560 (or, if downloaded or preloaded on your hard disk, delete the Software, or if provided as part of a collection, cease use of 
the Software). Title to the Winstone 96 Program and all copyrights, trade secrets and other proprietary rights therein are owned by Ziff-Davis. All 
rights therein, except those expressly granted to you in this Agreement, are reserved by Ziff-Davis. Title to each of the Application Programs, and 
all copyright, trade secrets and other proprietary rights therein, are owned by the publishers of the Application Programs. All rights in the version 
of each Application Program embodied in the CD-ROM (or if preloaded on your hard disk or downloaded or if provided as part of a collection, in 
the preloaded, downloaded or collected files(s)), except those expressly granted to you in this Agreement and to Ziff-Davis, are reserved by the 
publisher of that Application Program. 

1. Limited License

This Agreement grants you only limited rights to use the Software. Ziff-Davis grants you a non-exclusive, non-transferable license to use the 
Software on a single dedicated computer or on a file server networked with multiple PC computers for the sole purpose of conducting benchmark 
tests to measure the performance of computer hardware and operating system configurations. You have the right to make a single copy of the 
Software for archival purposes and the right to transfer a copy of the Software across an internal local area network only to the PC computers 
attached to such network; provided, however, that all such copies are considered Software hereunder, that all uses of such copies are governed by 
the terms and conditions of this Agreement and that you shall be responsible for all uses of such copies in violation of the terms and conditions of 
this Agreement. The only right you are granted with respect to the use of the Application Programs is the right to use such Application Programs 
only in conjunction with the Winstone 96 Program and only when the Winstone 96 Program is running.

Any and all other uses and reproductions (except for the making of an archival copy of Winstone 96) of such Application Programs as part of the 
Software are outside the scope of the license granted to you hereunder and are prohibited under the terms and conditions hereof. By way of 
example only, and without limiting any of the foregoing, you do not have the right (by electronic transfer or by any other means) to directly or 
indirectly (or to permit other persons or entities to directly or indirectly) (a) make a copy of any of the Application Programs or part thereof 
(except for an archival copy as provided above), (b) run, operate or use any of the Application Programs or any portion of any Application 
Program independently of the Winstone 96 Program, or (c) publish or distribute any of the Application Programs or any portion of any 
Application Program (except as required in a network environment as provided above). Ziff-Davis hereby grants you the right to publish, except 
in any country where a third party claims during the term of this license that such distribution infringes that party's proprietary rights, benchmark 
test results obtained by you from your use of the Software provided that with the publication of each such result you: 

A. Identify Ziff-Davis, the name and version number of the benchmark Software used (i.e., Ziff-Davis' Winstone® 96 ver. 1.0);

B. Identify the specific Winstone 96 score(s) being reported and in all cases include the Winstone 96 overall score.

C. Identify the exact name, processor speed and type, amount of RAM, amount of secondary RAM cache, if any, hard disk model, type of hard 
disk controller, and size of hardware hard disk cache, if any, of the PC used for the test (e.g., WXY Corp. Model 466 with 66-MHz Intel® 
486DX2-66 CPU, 8MB of RAM, 64KB RAM cache, 200MB hard disk, IDE controller, and no hardware disk cache); 

D. Identify the exact graphics adapter name, amount and type of RAM on it, graphics driver name and date, refresh rate, Microsoft® Video for 
Windows® version, and CODEC version that produced the result (e.g., XYZ Corp. XYZ Graphics adapter with 2MB VRAM with 
XYZ.DRV version 1.1 driver, a refresh rate of 72 Hz, Microsoft Video for Windows version 1.1e, and Intel Indeo™ Video version 3.2 
CODEC); 

E. Identify the exact CD-ROM drive model, CD-ROM controller model, CD-ROM controller RAM cache size (if any), and CD-ROM-specific 
software cache and size (if any) that produced the result (e.g., XYZ Corp. XYZ CD-ROM Quad-Speed drive, XYZ Corp. CD-ROM 
controller, with no controller RAM cache and no CD-ROM specific software cache); 

F. Identify the operating system version (e.g., MS-DOS® 5.0 and Microsoft Windows 3.1), size and type of software disk cache, if any (e.g., 
SMARTDRV 2MB cache), graphics resolution and color depth (e.g., 800 by 600 pixels with 256 colors), and any other special conditions 
used to achieve the result (e.g., disk compression utility ABC version 1.0 enabled); 

G. State that all products used in the test were shipping versions available to the general public;

H. State that the test was performed without independent verification by Ziff-Davis and that Ziff-Davis makes no representations or warranties 
as to the result of the test; and 

I. Follow proper trademark usage and acknowledge Ziff-Davis' trademark rights (e.g., "[ ] achieved an overall score of X Winstone® 96 ver. 
1.0 units. Winstone is a registered trademark or trademark of Ziff-Davis Publishing Company in the U.S. and other countries."). 

This Agreement and your rights hereunder shall automatically terminate if you fail to comply with any provision of this Agreement. Upon such 
termination, you agree to cease all use of the Software, cease the transfer of any copies of the Software and cease the publication of benchmark 



test results obtained by you from use of the Software. Further you agree to delete the Software and to destroy all tangible copies of the Software 
and other materials related to the Software in your possession or under your control, or, if downloaded or preloaded on your hard drive or if 
provided as part of a collection, to cease use of and to destroy any and all copies of the Software in your possession or under your control.

2. Additional Restrictions

A. You shall not (and shall not permit other persons or entities to) rent, lease, sell, sublicense, assign, or otherwise transfer the Software or this 
Agreement. Any attempt to do so shall be void and of no effect.

B. You shall not (and shall not permit other persons or entities to) reverse engineer, decompile, disassemble, merge, modify, include in other 
software or translate the Software, or use the Software for any commercial purposes, except for the publication of test results, as provided 
above.

C. You shall not (and shall not permit other persons or entities to) remove or obscure Ziff-Davis' copyright, trademark or other proprietary 
notices or legends from any of the materials contained in this package or downloaded.

D. You acknowledge that the Software contains Ziff-Davis' trade secret information and you agree not to disclose or disseminate such 
information other than as provided herein.

3. Limited Warranty and Limited Liability

THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU, AND ZIFF-DAVIS AND ITS 
AUTHORIZED DISTRIBUTORS ASSUME NO RESPONSIBILITY FOR THE ACCURACY OR APPLICATION OF OR ERRORS OR 
OMISSIONS IN THE SOFTWARE. IN NO EVENT SHALL ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
THE SOFTWARE, EVEN IF ZIFF-DAVIS OR ITS AUTHORIZED DISTRIBUTORS HAVE BEEN ADVISED OF THE LIKELIHOOD OF 
SUCH DAMAGES OCCURRING. ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS SHALL NOT BE LIABLE FOR ANY LOSS, 
DAMAGES OR COSTS, ARISING OUT OF, BUT NOT LIMITED TO, LOST PROFITS OR REVENUE, LOSS OF USE OF THE 
SOFTWARE, LOSS OF DATA OR EQUIPMENT, THE COSTS OF RECOVERING SOFTWARE, DATA OR EQUIPMENT, THE COST OF 
SUBSTITUTE SOFTWARE OR DATA, CLAIMS BY THIRD PARTIES, OR OTHER SIMILAR COSTS.

THE ONLY WARRANTY MADE BY ZIFF-DAVIS AND ITS AUTHORIZED DISTRIBUTORS IS THAT THE ORIGINAL PHYSICAL 
MEDIA IN WHICH THE SOFTWARE IS EMBODIED AND WHICH IS DISTRIBUTED BY ZIFF-DAVIS OR ITS AUTHORIZED 
DISTRIBUTORS SHALL BE FREE OF DEFECTS IN MATERIALS AND WORKMANSHIP. ZIFF-DAVIS' ENTIRE LIABILITY AND THE 
USER'S EXCLUSIVE REMEDY SHALL BE LIMITED TO THE REPLACEMENT OF THE ORIGINAL PHYSICAL MEDIA IF DEFECTIVE. 
THE WARRANTIES AND REMEDIES SET FORTH HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, 
EXPRESS OR IMPLIED. NO ZIFF-DAVIS DISTRIBUTOR, AGENT OR EMPLOYEE, OR THIRD PARTY, IS AUTHORIZED TO MAKE 
ANY MODIFICATION OR ADDITION TO THIS WARRANTY.

SOME STATES DO NOT ALLOW EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES OR LIMITATION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES; SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.

4. U.S. Government Restricted Rights

The Software is licensed subject to RESTRICTED RIGHTS. Use, duplication or disclosure by the Government or any person or entity acting on 
its behalf is subject to restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS 
(48 CFR 252.227-7013) for DoD contracts, in paragraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights clause in the 
FAR (48 CFR 52.227-19) for civilian agencies, or in the case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement to the FAR, or in 
other comparable agency clauses. The contractor/manufacturer is the Ziff-Davis Benchmark Operation, 1001 Aviation Parkway, Suite 400, 
Morrisville, North Carolina 27560.

5. General Provisions

Nothing in this Agreement constitutes a waiver of Ziff-Davis' rights under U.S. copyright laws or any other Federal, state, local or foreign law. 
You are responsible for installation, management, and operation of the Software. This Agreement shall be construed, interpreted and governed 
under New York law. If any provision of this Agreement shall be held by a court of competent jurisdiction to be illegal, invalid or unenforceable, 
the remaining provisions shall remain in full force and effect.



Trademarks
MacBench®, NetBench®, ServerBench®, WinBench®, and Winstone® are registered trademarks of Ziff-Davis 

Publishing Company.

Adobe™ and PageMaker™ are trademarks of Adobe Systems Incorporated.

Borland®, dBASE®, and Paradox® are registered trademarks of Borland International, Inc.

CorelDRAW!™ is a trademark of Corel Corporation.

Dell® is a registered trademark of Dell Computer Corporation.

Intel® is a registered trademark and Pentium™ is a trademark of Intel Corporation.

Lotus®, 1-2-3®, and Ami Pro® are registered trademarks of Lotus Development Corporation.

Microsoft®, Microsoft Access®, MS-DOS®, PowerPoint®, and Windows® are registered trademarks of Microsoft 
Corporation.

NetWare®, Novell®, WordPerfect®, and Quattro® are registered trademarks of Novell, Inc.

OS/2® is a registered trademark of International Business Machines Corporation.



Copyrights
Winstone 96 Version 1.0 © 1993-1995. Ziff-Davis Publishing Company. All rights reserved.

Adobe PageMaker version 5.0a for Windows © 1993-1995, Adobe Systems Incorporated. All rights reserved.

Borland dBASE 5.0 for Windows © 1984, 1994. Borland Paradox Version 5.0 for Windows    1985, 1994. Borland 
International, Inc. All rights reserved.

CorelDRAW! version 5.0E2 © 1994, Corel Corporation. All rights reserved.

Lotus Ami Pro Release 3.1 for Windows © 1988, 1994. Lotus 1-2-3 Release 5 for Windows © 1991, 1994 Lotus 
Development Corporation. All rights reserved.

Microsoft Access version 2.0c for Windows © 1989-1994. Microsoft Excel version 5.0c for Windows © 1985-1994. 
Microsoft PowerPoint version 4.0c for Windows © 1987-1994. Microsoft Word version 6.0c for Windows © 
1983-1994. Microsoft Works version 3.0b for Windows © 1987-1993. Microsoft Corporation. All rights 
reserved.

Quattro Pro Version 6.01 for Windows © 1994, Novell, Inc. All rights reserved.

WordPerfect for Windows version 6.1 © 1991, 1994. Novell, Inc. All rights reserved.



Overview
This is the tester's handbook for Winstone® 96. This handbook provides the minimum information you 
need to install Winstone, run its tests, and save the results. The handbook also includes some 
introductory material on how to read and analyze Winstone 96's scores. For additional information on 
what happens when you run a test and what can affect a PC's scores, see Chapter 15 in the 
Understanding and Using Winstone® 96 Version 1.0 manual.

NOTE:
Before you do anything with the software, you need to read the license agreement at the front of this 
handbook. (The same license agreement appears on the PC's screen the first time you start Winstone 
96.)



Finding the information you need
This handbook includes the following parts:

Part 1: Updated applications
Lists the changes and new features in this year's benchmark.

Part 2: Winstone 96 minimum requirements
Provides a list of Winstone 96's minimum requirements, explains what you need to think 
about before you install or run the benchmark, and gives brief instructions on how to 
install the program's files.

Part 3: Using the Configuration Information window
Explains how to use the Configuration Information window, run Winstone 96's suites, 
save results, and run Winstone 96's suites in batch mode.

Part 4: Viewing scores
Explains how to view results and briefly discusses what the results for the main suite 
mean about a PC's performance.

Part 5: Getting technical support
Tells you how to contact us if you have technical questions or problems with Winstone 96.

At the end of this handbook, you'll find an appendix that briefly introduces Winstone 96's main concepts. 
While you don't need to read the appendix to successfully run Winstone 96's suites, you may want to read 
it for a clearer understanding of how the benchmark works.



Conventions this handbook uses
This handbook uses a few general conventions. For example, it:

· Uses the pronoun "we" to refer in general to either the Ziff-Davis Benchmark Operation (ZDBOp) 
or Ziff-Davis.

· Uses bold type face for DOS and Windows® commands, file names, and directory names. For 
example, you'll see sentences similar to the following:

"The WS96HBK.DOC file is in the \ZDBENCH\DOCS\WS96\HANDBOOK directory on the CD-
ROM."

· Uses a monospace or typewriter font for information you must enter verbatim from the command 

line. The handbook also displays system responses that appear on the PC's screen in the same 
font. For example:

D:\ZDBENCH\WS96\SETUP.EXE

· Uses the terms "select" and "choose" in the same way Windows documentation uses these 
terms. In Windows documentation, the terms "select" and "choose" have different, and specific, 
meanings. When you select an item, you mark it with the selection cursor, and the selection 
appears as a highlight, a dotted rectangle, or both. You also select check boxes in dialog boxes. 
Selecting alone doesn't initiate an action.

You choose an item to carry out an action. For example, when you choose the Winstone 96 icon, 
Winstone 96 opens its main window. You can also choose an item from a menu or choose a 
command button in a dialog box. You often need to select an item before you can choose it.



Available Winstone 96 documentation

This document: Is located in the: And contains:
README.WRI \ZDBENCH\WS96 directory on the CD-

ROM.
The license agreement, a list of 
new features, and a list of known 
problems as of the CD-ROM's 
release.

Winstone® 96 Version 
1.0 Tester's Handbook
(WS96HBK.*)

\ZDBENCH\DOCS\WS96\HANDBOOK 
directory on the CD-ROM. The CD-
ROM may include three different 
formats of the handbook (.DOC, .TXT, 
and .RTF).

The minimum information you 
need to install Winstone 96, run 
the tests, and analyze the 
results. (This is the document 
you're reading now.)

The on-line help also contains 
most of the information in this 
tester's handbook.

Understanding and 
Using Winstone® 96 
Version 1.0
(WS96REF.*)

\ZDBENCH\DOCS\WS96\REF 
directory on the CD-ROM. The CD-
ROM may include three different 
formats of the manual (.DOC, .TXT, 
and .RTF).

The Winstone 96 reference 
manual.



Updated applications
Winstone 96 includes the most current available versions of all the applications it uses in its tests. Here's 
a list of Winstone 96's categories, applications, and application version numbers.

Business Graphics/DTP: Adobe™ PageMaker™ 5.0a for Windows
Corel Corporation CorelDRAW!® 5.0E2
Microsoft PowerPoint® 4.0c for Windows

Database: Borland® dBASE® 5.0 for Windows
Borland Paradox® 5.0 for Windows
Microsoft Access® 2.0c for Windows
Microsoft Works 3.0b for Windows*

Spreadsheet: Lotus® 1-2-3® Release 5 for Windows
Microsoft Excel 5.0c for Windows
Microsoft Works 3.0b for Windows*
Novell® Quattro® Pro 6.01 for Windows

Word Processing: Lotus Ami Pro® Release 3.1 for Windows
Microsoft Word 6.0c for Windows
Microsoft Works 3.0b for Windows*
Novell WordPerfect® 6.1 for Windows

____________________

* To reflect the way most users work with Works for Windows, Works for Windows is part of three 
categories:    Database, Spreadsheet, and Word Processing. To make the performance of Works 
for Windows have the right amount of effect on each of those three categories, Winstone 96 
spreads the weight for Works for Windows across those categories in the following way:    By 
putting 20% in the Database category, 40% in the Spreadsheet category, and 40% in the Word 
Processing category.



The Configuration Information window
Winstone 96 checks the PC under test to make sure it meets a minimum set of requirements before a test 
run begins. If Winstone 96 finds any areas that may cause the test to fail, it reports those areas in the new 
Configuration Information window. (For information on disabling the configuration check, see Disabling 
Winstone 96's configuration check.)

NOTE:
You can open the Configuration Information window from the Run menu on the main window menu bar 
without running a test suite.

You may also want to use the Configuration Information window to compare the test PC with either a pre-
set list of optimization tips or a custom configuration file you create.

The Configuration Information window has three sections:

· Potential Problems. Lists any area of the PC's setup and configuration that doesn't meet the 
minimum test requirements.

· Optimization Tips. Compares the PC's setup and configuration to a pre-set list of optimization 
tips.

· Custom Configuration File. Compares the PC's setup and configuration to a custom 
configuration file. For more information, see Custom Configuration File.

For information on how to use this window, see Using the Configuration Information window or Chapter 8, 
"Using the Configuration Information Window," in the Understanding and Using Winstone® 96 Version 1.0 
manual.



Improved cleanup program
As with previous versions of Winstone, when you exit the benchmark program, it restores the test PC to 
its original state. However, Winstone 96 includes an improved cleanup program that automatically 
restores the PC to its pretest state even when there are problems with the benchmark's test run.

For example, if you need to interrupt a Winstone 96 test run, or if Winstone 96 halts, stops, or hangs the 
PC and you must exit Winstone 96 in any way other than clicking the Exit button, all you need to do is 
restart Windows. Winstone 96's cleanup program will automatically run when you restart Windows and 
restores the PC's system files.



Disclosure fields for multimedia
Winstone 96 includes new Disclosure fields for multimedia. The following table lists the new fields as they 
appear in the WST_SYS.DBF results file.

NOTE:
The following list shows the fields exactly as they appear in the results file. If you use a .DBF-compatible 
application to view the file, the fields may appear in a different order.

Result: Result field name: Field 
type:

Width 
(bytes):

CD-ROM drive description CD_DRV_DES Character 80

CD-ROM controller description CD_CONT_DE Character 80

CD-ROM controller RAM CD_CONT_RA Character 10

CD-ROM software cache description CD_SCH_DES Character 80

CD-ROM software cache size CD_SCH_SZ Character 10

Sound adapter description SND_ADP_DE Character 80

Video for Windows version VFW_VER Character 20

Win32s version WIN32S_VER Character 20

Windows drivers WIN_DRVS Memo

If you'd like more information on using the database files, see Working with database files. For additional 
information on the database fields Winstone 96 uses, see Appendix A, "The Database Files," in the 
Understanding and Using Winstone® 96 Version 1.0 manual.



Error messages log file
Winstone 96 logs all error messages in a file named ERRORS.TXT in the parent directory where you 
installed the benchmark (probably \ZDBENCH). (Winstone 96 shares this log file with WinBench® 96.) 
The automatic logging feature frees you from having to keep track of any error messages Winstone 96 
may display during a test run.

NOTE:
The error message included in Winstone 96's ERRORS.TXT file do not include errors from the 
applications or application scripts Winstone 96 uses.

You can view the ERRORS.TXT file with any text editor.



Winstone 96 minimum requirements
If the PC doesn't meet Winstone 96's minimum requirements, Winstone 96 won't be able to run the tests 
properly. The following chart lists the minimum requirements to install and run Winstone 96.

Windows 3.1 or 3.11* or Windows for Workgroups 3.1 or 3.11* Windows 95
MS-DOS® (or compatible) version 5.0 or later or Novell® DOS 7 N/A

Microsoft CD Extension software or equivalent N/A

8MB of RAM

130MB of free disk space for a full install (if you're not running Winstone 96 from the CD-ROM or network).
Winstone 96 requires 90MB of free space for the base directory, and an additional 40MB (whether you're 
running Winstone 96 from the CD-ROM, the hard disk, or a network drive) of free space for the working 

directory.†

80386 (or compatible) or higher processor

CD-ROM drive

A swapfile for Windows at least 6MB in size.

A temporary directory with 2MB or more of available space.

VGA resolution (640x480) or higher graphics adapter

* We didn't test Winstone 96 on earlier versions of these operating systems. So, we can't 
guarantee it will run on them, or, if it does, that the results will be valid.

† The exact software and hardware requirements for a PC depend on how you choose to run 
Winstone 96. For information on the different ways to run Winstone 96, see the next section.



Think about how you want to run Winstone 96
Winstone 96 measures the performance of a PC by executing actual Windows-based applications. The 
CD-ROM that includes Winstone 96 in its \ZDBENCH\WS96 directory also contains all the files and 
application portions Winstone 96 needs; therefore, you don't need to install any applications to run 
Winstone 96.

When you run Winstone 96, it copies the files it needs from a base directory to a work directory. The base 
directory holds all Winstone 96's application files, and the work directory holds the files Winstone 96 
creates when you run a suite.

You can set these directories to any path you want, but the work directory should be on the hard disk of 
the PC you plan to test. (For example, the base directory could be on a network drive, F:
\ZDBENCH\WS96, and the work directory could be on the test PC's hard disk, C:
\ZDBENCH\WS96\WORK.)

NOTE:
The location of the base directory doesn't affect a PC's scores.

The following picture illustrates the different ways you can run Winstone 96 and the amount of free disk 
space you need for each option.

Figure 1:    Options for running Winstone 96



Installing Winstone 96
To install Winstone 96, execute SETUP.EXE from the \ZDBENCH\WS96 directory on the CD-ROM or 
from a network file server.

NOTE:
If you received Winstone 96 on CD-ROM, that CD-ROM may contain the Ziff-Davis PC Benchmarks 
Installer program. With this installer program, you can install both Winstone 96 and WinBench 96, as well 
as other programs WinBench 96 requires, at one time. If you're running Windows 95, the installer 
program starts automatically if the CD-ROM is in the CD-ROM drive. If you need to start the installer 
program, execute INSTALL.EXE from the CD-ROM's root directory using the File | Run command under 
Windows.

The setup program displays a series of screens and dialog boxes in which you enter information such as 
the directory where you want Winstone 96 to install its files. Each of these screens contains text 
explaining what you should do.

NOTE:
Although you don't have to install Winstone 96's files to the default directory, \ZDBENCH\WS96, you 
should choose the default directory for compatibility with other Ziff-Davis benchmarks.

While the setup program is installing Winstone 96's files, it displays a status bar. If you want to stop the 
setup procedure, choose the Cancel button. (It may take a few moments for Winstone 96 to stop the 
procedure once you've chosen the button.)

Once the setup process is complete, Winstone 96 displays a verification box to let you know it has 
installed the files it needs. Choose the OK button to exit this box.

The setup program also creates a \ZDBENCH\RESULT96.ZDB directory for the common results 
database if it doesn't already exist. If you didn't install Winstone 96 in a \ZDBENCH directory, Winstone 
96 creates the RESULT96.ZDB directory in the directory where you installed the files.



Using the Configuration Information window
Winstone 96 checks the PC under test to make sure it meets a minimum set of requirements before a test 
run begins. If Winstone 96 finds any areas that may cause the test to fail, it reports those areas in the new 
Configuration Information window. (For information on disabling this check, see Disabling Winstone 96's 
configuration check.)

The Configuration Information window has three sections:

· Potential Problems

· Optimization Tips

· Custom Configuration File

When Winstone 96 displays this window, the section that contains any warnings will be on top. For 
example, if Winstone 96 doesn't find any potential problems with the PC's setup and configuration, but 
instead, finds a setting in the PC's system files that differs from the pre-set list of optimization tips, it will 
display the Optimization Tips section first. (You can look at the other sections if you'd like. Just click on the 
button at the top of the window that corresponds to the section you wish to view.)

In the top left corner of the Configuration Information window, you'll find the Options drop-down menu. 
You can use this menu to tell Winstone 96 what areas to check before running tests (for example, you can 
have Winstone 96 check potential problems and nothing else) and to load or unload a custom 
configuration file.

Related Topics:
Potential Problems

Optimization Tips

Custom Configuration File

Disabling Winstone 96's configuration check



Potential Problems
The following chart explains briefly what to do if Winstone 96 warns you of problems that may cause a 
test to fail.

Potential Problem: Solution:
Low system resources Winstone 96 requires at least 60% of memory in the GDI and USER 

heap free for its applications. Close any other applications before 
continuing with the test run.

Swap file too small Winstone 96 requires a total of 14MB of memory, of which at least 8MB 
must be physical RAM.

Not enough free disk 
space

Winstone 96 needs a minimum of 40MB of free disk space for its work 
directory. You can:

· Change the work directory to another disk drive on the test PC that has enough 
free disk space.

· Free disk space by deleting files and/or applications from the test PC's hard 
disk.

Not enough free TEMP 
space

Winstone 96 needs at least 2MB of available space in a TEMP directory. 
You can:

· Make sure the TEMP directory is on the same drive as the Winstone 96 work 
directory.

· Make sure the TEMP directory is empty.

· Increase the amount of space for the TEMP directory by putting the directory on 
a drive that has adequate space or by deleting files and/or applications to 
increase the available space on the drive where TEMP is located.

Missing VSHARE device 
driver

On Windows 3.1 and Windows for Workgroups 3.11, Winstone 96 
requires VSHARE. If the VSHARE driver isn't installed, you can reinstall 
Winstone 96 and when the program asks if you want to install the 
VSHARE.386 driver, choose Yes.

Missing display fonts If the PC is missing any of the fonts Winstone 96 needs to successfully 
run its tests, the Configuration Information window lists the missing 
fonts. You'll need to install these fonts before continuing. (To see a list of 
fonts installed on the test PC, select Fonts from the Windows Control 
Panel program group.)

Quit other applications Running Winstone 96 while you have other applications running in the 
background can affect a PC's scores. Winstone 96 lists all other 
applications that are running, but will not automatically terminate these 
other applications. You should quit all other applications before running 
a Winstone 96 test.



Optimization Tips
When Winstone 96 performs its configuration check, it notes areas where the PC differs from a pre-set list 
of optimization tips. For example, when you run Winstone 96, the load= entry in the [Windows] section 
of the PC's WIN.INI file should be empty. So, if load= isn't empty, Winstone 96 lists this difference on the 

Optimization Tips page.

For information on why a certain setting may cause problems for Winstone 96, highlight the setting in the 
Configuration Information window and Winstone 96 displays an explanation at the bottom of the window.



Custom Configuration File
In addition to comparing the PC to a list of pre-set optimization tips, you can also use a custom 
configuration file. Then, when Winstone 96 performs its configuration check, it will compare the pre-
defined settings in the custom configuration file with the settings the test PC uses. If you're testing 
multiple PCs, you can use a custom configuration file to assure that each PC matches the custom 
settings.

Winstone 96 includes a sample configuration file (SAMPLE.CFG) in the \ZDBENCH\WS96\UI directory 
on the CD-ROM.

To create a custom configuration file, first copy the SAMPLE.CFG file to another file name (for example, 
CUSTOM.CFG). Then, edit the custom file so it contains the settings you want. (For information on the 
different settings the SAMPLE.CFG file can contain, see Creating a custom configuration file.)

After you've edited the custom file and before you run any Winstone 96 tests, go to each PC you want to 
test and follow the steps below:

1. Select Run | Configuration Information... from the Winstone 96 main window.

2. Select Option | Load custom configuration file... from the Configuration Information window.

3. Enter the directory and file name of the custom file in the Load Custom Configuration File dialog 
box.

4. Select OK.

After you load the custom file, Winstone 96 continues to check differences between the custom file and 
the PC under test for the remainder of the current session and in future sessions on that PC until you 
unload the file.

To unload a custom configuration file:

1. Select Run | Configuration Information... from the Winstone 96 main window.

2. Select Options | Unload custom configuration file from Configuration Information window.



Disabling Winstone 96's configuration check
You may want to disable the configuration check if you're running Winstone 96 on the same PC over and 
over again without changing that PC's configuration. Once Winstone 96 performs the configuration check 
and you're sure the PC is set up correctly, you can then disable the check. You can also tell Winstone 96 
to perform only certain portions of its configuration check. For example, you could have the program 
check for Potential Problems but not check for Optimization Tips.

NOTE:
If you change the PC's configuration at all, you should enable the configuration check. The configuration 
check is a good way to be certain Winstone 96 will complete the test without problems.

To disable one portion or all of the configuration check:

1. Select Options | Check before running tests from the Configuration Information window.

2. From the sub-menu Winstone 96 displays, select those areas you want the program to check. For 
example, if you only want Winstone 96 to look for potential problems, select Potential Problems 
from the list. Winstone 96 marks each selection with a check mark.

If you don't select any of the items in this list, Winstone 96 doesn't perform its configuration check.

Until you change these options, Winstone 96 will perform the configuration checks you select for the 
current session and for future sessions.



Running the Overall Winstone 96 suite
To run the main suite:

1. Choose Winstone 96 from the Ziff-Davis Benchmarks program group to open the main window.

NOTE:
If you haven't previously licensed Winstone 96, you'll have to read and agree to the license 
agreement before you can continue.

If Winstone 96 fails during initialization with a General Protection Fault (GPF) or system hang, 
you can use three command line options to disable Winstone 96's automatic detection of some 
disclosure fields.

The NOCPUCHECK option prevents Winstone 96 from detecting the CPU type and speed and 
the FPU type.

The NOVIDCHECK option prevents Winstone 96 from detecting the display refresh rate, VESA 
support, and graphics adapter types. The NOVIDCHECK option is useful if display corruption 
occurs after Winstone 96 initializes.

The NOREGCHECK option prevents WinBench 96 from gathering information from the Windows 
95 or Windows NT registry.

The NOSYSCHECK option disables nearly all detection.

2. Choose the Run button. (When you open the main window, Winstone 96 displays "Overall 
Winstone 96" in the list of names to the right of the Run button. So, choosing the Run button runs 
the main test.)

NOTE:
By default, Winstone 96 displays the Configuration Information window if there are problems that 
may cause the test to fail. If there are problems, you should select Cancel Test in this window and 
then correct the problems before continuing. (See Using the Configuration Information window for 
more information.)

The time Winstone 96 takes to run its main suite varies based on the PC's speed and configuration. Here 
are a few examples to give you an idea of how long it took to run the suite on machines in our research 
center. Faster machines will take less time, while slower machines will take more time.

This machine: Took approximately this much time:
A typical Pentium™ 100 with 32MB of RAM 27 minutes

A typical Pentium 66 with 16MB of RAM 40 minutes

A typical 486DX2/66 with 16MB of RAM 1 hour

A typical 486SX/25 with 8MB of RAM 2 hours

While Winstone 96 is running the main suite, you'll see application windows opening and closing on the 
PC's screen as Winstone 96 executes its application scripts. When the suite finishes, Winstone 96 
displays the PC's results in the Chart of Results.



Interrupting a test run
If you need to interrupt a suite, choose the Cancel button when Winstone 96 installs an application's files. 
If you need to stop a test run immediately, press Ctrl-Alt-Del to quit Winstone 96, and then restart 
Windows.

IMPORTANT NOTE!
If you halt Winstone 96 using Ctrl-Alt-Del, you should exit Windows, reboot the PC, and restart Windows 
so Winstone 96's cleanup program can restore the PC's system files to their original state.



Saving scores
After Winstone 96 finishes a test suite, it automatically displays that suite's scores in the Chart and Table 
of Results windows.

To save results:

1. Choose the Save button from the Winstone 96 functions window.

Winstone 96 displays the Save to Database dialog box.

NOTE:
You must enter a Description for the test run before you can save results. If you haven't entered a 
Description, Winstone 96 prompts you for that information before you can continue the save 
operation. It's also a good idea to check the other fields in the Disclosure Questionnaire for 
accuracy. After you've entered a Description and verified the other fields, choose the Continue 
with Save button.

2. Choose the Save button in the Save to Database dialog box.

Winstone 96 saves the results to the current database using the Description you supplied, along 
with other information in the Disclosure.

NOTE:
You can change the destination database by choosing the Database button in this window.



Running a Category suite
Winstone 96 includes four application category suites, and when you run the main suite, Winstone 96 
reports the overall score as well as scores for each of these category suites. In addition to running the 
main suite, you can also run each of the category suites individually. Each category suite runs just the 
application scripts for the applications within that category.

The following table tells you which application scripts Winstone 96 runs when you choose a particular 
category suite.

This suite: Runs the scripts for:
Business 
Graphics/DTP

PageMaker, CorelDRAW!, and PowerPoint.

Database Access for Windows, dBASE, Paradox for Windows, and Works for 
Windows.

Spreadsheet 1-2-3 for Windows, Excel, Quattro Pro for Windows, and Works for Windows.

Word Processing Ami Pro, Word for Windows, WordPerfect for Windows, and Works for 
Windows.

To run a category suite:

1. Select the category suite name from the list of names to the right of the Run function button. (To 
display this list, choose the down arrow to the right of the text box.)

2. Choose the Run button.

After you choose the Run button, if Winstone 96 finds any circumstance that may cause the suite to fail, it 
displays the Configuration Information window and warns you about the potential problem (see Using the 
Configuration Information window for more details).

Winstone 96 does basically the same thing when you run an application category suite as when you run 
its main suite. The differences between a category suite and the main suite are:

Winstone 96 runs only those application scripts included in that category.

Winstone 96 computes a score for just that category.

The time Winstone 96 takes to run its category suites varies based on the PC's speed and configuration. 
Here are a couple of examples to give you an idea of how long it took to run this suites on machines in 
our research center. Faster machines will take less time, while slower machines will take more time.

· Machine A is a typical Pentium 66 with 16MB of RAM.

· Machine B is a typical 486SX/25 with 8MB of RAM (Winstone 96's base machine).

This category suite: Machine A: Machine B
Business Graphics/DTP 10 minutes 34 minutes 20 seconds

Database 12 minutes 36 seconds 40 minutes 30 seconds

Spreadsheet 10 minutes 30 seconds 35 minutes

Word Processing 14 minutes 14 seconds 47 minutes 35 seconds

NOTE:



The time it takes to run all four category suites won't equal the time it takes to run the main suite. 
Winstone 96 runs the Microsoft Works script in each of three different categories. This means, if you run 
all the category suites, Winstone 96 runs the Microsoft Works script three times instead of the one time it 
would run the script if you ran the main suite. So, the total execution times for all the category suites will 
be slightly more than the total execution time for the main suite.



Running Winstone 96 in batch mode
You don't have to sit at the PC and click the buttons to run Winstone 96's suites. To make the best use of 
your time, you may decide to run Winstone 96 in batch mode. When you run Winstone 96 this way, it gets 
the information it needs to run the suites from a file called RUNWS.INI. This file supplies the environment 
settings, the names of the tests Winstone 96 will run, and the names for the database files it produces. 
Winstone 96 includes a prototype RUNWS.INI file in the \ZDBENCH\WS96\UI directory on the CD-ROM.

NOTE:
You can only use the Winstone 96 RUNWS.INI file with Winstone 96. Winstone 95 won't accept this file 
format.

To run Winstone 96 in batch mode:

1. Copy the RUNWS.INI prototype file to another file name (for example, MYFILE.INI).

2. Edit the new file so it contains the information Winstone 96 needs.

You can use any text editor to modify this file. You can also use the StepN section(s) of this file to 
refer to files that define suites to run in that step. The \ZDBENCH\WS96\UI directory on the CD-
ROM that includes Winstone 96 contains the following sample files you can use to refer to in the 
StepN section(s):

This file: Runs this suite:
OVERALL.WSS Overall Winstone 96

BG_DTP.WSS Business Graphics/DTP

DB.WSS Database

SS.WSS Spreadsheet

WP.WSS Word Processing

For complete information on the different sections of the RUNWS.INI file you can modify, see 
Chapter 10, "Running Winstone 96's Tests," in the Understanding and Using Winstone® 96 
Version 1.0 manual.

3. After you've edited and saved the new file, run Winstone 96 with the AUTO command option and 
specify the name of the new file.

For example, if MYFILE.INI is the edited copy of the prototype file, you'd use the following 
command line:

WS96 AUTO MYFILE.INI

How you execute Winstone 96 in batch mode depends on the Windows shell you're using.

· If you're using Program Manager, select Run from the Program Manager File menu. Use the 
Browse feature to enter the Winstone 96 command line, and then add the AUTO option and 
the name of the .INI file to that command line.

· If you're using Explorer, select Run from the Start menu. Use the Browse feature to enter the 
Winstone 96 command line, and then add the AUTO option and the name of the .INI file to 
that command line.

If you want to automate this process so Winstone 96 runs in batch mode each time Windows 



starts, you can add the Winstone 96 icon with the AUTO command line option and the name of 
the .INI file to the Windows StartUp group.



Viewing scores
You can view scores saved to a database from the Chart and Table of Results. After you run a test, 
Winstone 96 automatically displays the score(s) for that test in the Chart of Results. The Chart of Results 
shows the name of the suite and the score for that suite in a horizontal bar graph.

Related Topics:
Adding results to the display

Changing the display

Removing results from the display

Printing results



Adding results to the display
To add results to the Chart and Table of Results windows, choose the Compare... button in the Functions 
window. Winstone 96 then displays the Comparison Machines dialog box. (You only need to add results 
to these windows if you want to view results other than the current results.) You can display up to five sets 
of comparison results in the Chart and Table of Results windows.

From the Comparison Machines dialog box, you can add results from:

· A database by choosing the Add from Database... button.

· An exported file by choosing the Import from File... button.



Changing the display
You can use the Display option from the Edit drop-down menu to change the way Winstone 96 displays 
its results.

Choosing this option: Displays:
All Categories Scores for the main suite and category suites.

Categories Run Scores for the suites run during the current session.

Selected Categories Scores for the suites as specified in the drop-down list of suites to the 
right of the Run function button. For example, if the drop-down list 
displays "Word Processing," then Winstone 96 displays the score(s) for 
its Word Processing suite.



Removing results from the display
To remove a set of results from the Chart and Table of Results:

1. Open the Comparison Machines dialog box by choosing the Compare... button in Winstone 96's 
Functions window.

This dialog box lists all the results currently displayed in the Chart and Table of Results. (You can 
display up to four sets of comparison results in the Chart and Table of Results.)

2. Select the set of results you'd like to remove from the display, and then choose Remove.

Winstone 96 removes that set of results from the Chart and Table of Results. It doesn't, however, 
permanently delete those results from the database. (If you'd like to know how to permanently 
remove results from the database, see Deleting results permanently from the database.)



Printing results
You can print the current results, the Chart and Table of Results, and the Disclosure using the Print 
option from the File menu.

If you want to print . . . Then choose . . .
The results and Disclosure 
information for tests run during the 
current session.

Current results.

The current contents of the Chart of 
Results and/or the Table of Results.

Chart of Results and/or Table of Results.

Disclosure information. Disclosure. (Winstone 96 prints the Disclosure information for 
the current results. If you want to print Disclosure information for 
other sets of comparison results, change the Description listed 
at the top of the Disclosure window before selecting Print from 
the File menu.)

When you choose one of these options, Winstone 96 prints the currently selected default printer.



Working with database files
Winstone 96 saves scores and disclosure information in a database format it shares with WinBench 96. 
You use results stored in a database as comparison machines in the Chart and Table of Results windows.

Winstone 96 stores results in a database directory. The database directory typically has an extension of 
.ZDB. The database directory contains many dBASE-compatible tables and indexes.

If you installed Winstone 96 in a subdirectory of \ZDBENCH, the setup program creates a database 
directory called \ZDBENCH\RESULT96.ZDB. If you didn't install Winstone 96 under a common 
\ZDBENCH directory, it creates the RESULT96.ZDB database directory in the directory where you 
installed the program files. Winstone 96 can't then share the database with WinBench 96.

When you're working with database files:

· Always treat a database directory as a single object.

· Always move, copy, or delete the entire directory.

· Never move, copy, delete, or rename the files in a database directory.

· Never use a dBASE-compatible database management system to edit the database directory. 
Doing so may break the relationship between the files and the benchmark, and you'll lose the 
results.

NOTE:
You can merge the contents of one database into another using the Merge Databases... option from the 
File drop-down menu. Winstone 96 copies all results from the source database to the target database. 
(For more information, see Merging results into one database.)

Winstone 96 stores results in a database using a key consisting of the Description, Variant1-5, PIN, and 
Project fields of the Disclosure. You can store many sets of results using the same key. Winstone 96 
distinguishes the results by a unique time stamp.

Related Topics:
Merging results into one database

Exporting results

Deleting results permanently from the database



Merging results into one database
Winstone 96 lets you merge results from one database into another. When you merge two databases, 
you specify a target database and a source database. The target database is the database to which you 
wish to add results. The source database contains the records you wish to add to the target database.

To merge databases:

1. Select Merge Databases... from the File menu in the main menu bar. Winstone 96 then displays 
its Merge Databases dialog box.

2. Select the target and source databases.

3. Choose Merge.

Winstone 96 adds all the records from the source database to the target database. To view these records, 
you need to add them to the display (see Adding results to the display).

NOTE:
Depending on the number of records in the source database, it may take a while to merge the records 
from one database to another.



Exporting results
In addition to saving results to a database, you can export results to an ASCII text file (.TXT), a Lotus 1-2-
3 spreadsheet (.CSV), an Excel spreadsheet (.XLS), or a Windows Metafile (.WMF) for use in other 
applications.

To export results:

1. Select Export from the File menu.

You can export: Which contains: To this format:
Current Results Results and Disclosure for the tests run in the current 

session
.TXT, .CSV, or .XLS

Chart of Results Results the Chart of Results currently displays .WMF

Table of Results Results currently listed in the Table of Results .TXT

Disclosure The information currently listed in the Disclosure 
window

.TXT

Choosing any of the above options from the Export submenu displays the Export Results to File 
dialog box.

2. Enter the name of the file in the File Name dialog box. (You can change the drive and directories 
using the Drives and Directories portions of this dialog box.)

3. Choose OK.

Winstone 96 saves the results to the file name and format you specified.



Deleting results permanently from the database
To permanently delete a set of results from the database:

1. Select Delete... from the File menu in the main menu bar. Winstone 96 then displays its Delete 
Results from Database dialog box.

NOTE:
Winstone 96 only lets you delete select records from its database. You can't delete an entire 
database from within Winstone 96.

When you open the Delete Results from Database dialog box, Winstone 96 automatically 
displays all the records in the current database. (To change the database, choose the Database... 
button.)

2. Locate the record(s) you want to delete from the list of records.

To select more than one record, hold down the Shift key then click on the additional record 
name(s).

3. Choose Delete.

Winstone 96 prompts you with a warning asking if you're sure you want to delete the selected 
record(s).

4. Choose Yes, and Winstone 96 removes the selected record(s) from its database and closes the 
dialog box.



Working with Disclosure information
When you start Winstone 96, it checks the PC's configuration and stores the information it finds in the 
Disclosure. When you save a set of scores, Winstone 96 saves the disclosure information for that set of 
scores. If you publish results, you'll need to include information in the Disclosure with the results you 
publish.

NOTE:
If you run and save several suites on the same PC with the exact same configuration, Winstone 96 only 
stores the PC's configuration information once to conserve disk space.

Related Topics:
Viewing Disclosure information for the current displayed scores

Viewing Disclosure information for other sets of scores

Editing the Disclosure Questionnaire

Printing Disclosure information



Viewing Disclosure information for the current displayed scores
To view the disclosure information for each set of scores currently displayed in the Chart and Table of 
Results, choose Edit | Disclosure from Winstone 96's main menu.

By default, Winstone 96 displays the disclosure information for the current set of scores first. Winstone 96 
uses a drop-down list to display the Description for each set of scores you're currently displaying.

Disclosure information for a PC will most likely cover more than one page of the Disclosure window. Use 
the scroll bars to view portions that don't fit within the boundary of the window.



Viewing Disclosure information for other sets of scores
To look at disclosure information for another set of scores:

1. Select the down arrow to the right of Current Results.

2. Select the Description for the set of scores whose Disclosure information you wish to view.

Winstone 96 then changes the display to show the Disclosure information for that test run.



Editing the Disclosure Questionnaire
If you need to add to or change the Disclosure information about the PC, you can edit Winstone 96's 
Disclosure Questionnaire. There are two ways to edit the questionnaire. You can choose:

· The Edit button if the Disclosure window is open.

· The Disclosure Questionnaire option from the Edit menu in the main window menu bar.

Either of these actions opens the Disclosure Questionnaire window.

To update the Disclosure Questionnaire:

1. Select the group on the left-hand side of the window that corresponds to the area of the 
Disclosure you wish to edit.

When you select one of these groups, Winstone 96 changes the Disclosure Questionnaire 
window to display just the information about that group. For example, if you want to edit the 
Description, select the button beside Description, and Winstone 96 changes the display in the 
window to the Description information.

NOTE:
Winstone 96 by default displays the first group, Instructions, each time you open the Disclosure 
Questionnaire.

2. Once you have the Disclosure Questionnaire information the way you want it, choose the Update 
Disclosure button.

If at any point you wish to exit the Disclosure Questionnaire window without saving the changes 
and updating the disclosure, choose the Cancel button. When you choose either the Update 
Disclosure or Cancel buttons, Winstone 96 automatically closes the Disclosure Questionnaire 
window.



Printing Disclosure information
To print Disclosure information:

1. Select Print from the File menu in Winstone 96 main window.

2. Select the Disclosure... option from the Print submenu.

When you print the Disclosure information, Winstone 96 prints the information currently displayed in the 
Disclosure window.

NOTE:
If you're displaying results for several different types of machines, you can print disclosure information for 
each of them. To specify the set of comparison results for which you want to print the Disclosure, change 
the Description listed above the Disclosure information in the Disclosure window and then select Print 
from the File menu.



What the numbers mean
Winstone 96 runs today's top-selling Windows-based applications. For each application, Winstone 96 
performs tasks the way typical users would perform tasks in the application. This approach lets Winstone 
96 reflect the center of the software market.

So, Winstone 96's scores represent how the PC performs these tasks when running these Windows-
based applications. Winstone 96 gives you an accurate and repeatable measurement of how a PC runs 
those applications under Windows.

Remember, a PC's configuration will affect its Winstone 96 scores. Comparing scores for two machines 
with different configurations is at best a potentially confusing experience. For more information on how to 
make the most accurate comparison possible, see Making sure a comparison is valid.

Related Topics:
Bigger means better:    Comparing Winstone 96 scores

The units Winstone 96 uses



Bigger means better:    Comparing Winstone 96 scores
When you first look at Winstone 96's Chart of Results, the numbers may seem a little overwhelming. The 
most important thing to remember, however, is with Winstone 96, bigger numbers mean better 
performance.

To make it easier to understand a PC's scores, Winstone 96 has a base machine. The base machine 
receives a score of 10.0 Winstone 96 units on the overall suite. The same base machine receives a score 
of 1.0 Winstone 96 units on each category suite. (For statistics on the base machine, see Using the base 
machine to compare results.)

So, if a PC scores 20.0 Winstone 96 units on the main suite, it's two times as fast as the base machine at 
executing the main suite. Or, if a PC scores 5.0 Winstone 96 units on the main suite, the base machine is 
twice as fast as that PC at executing the main suite.

You can carry this over to Winstone 96 scores for any two machines. For example, if Machine A scores 
20.0 Winstone 96 units on the main suite and Machine B scores 40.0 Winstone 96 units on the main 
suite, then Machine B is twice as fast as Machine A at executing the "Overall Winstone 96" suite.

For the category suites, if a PC scores 2.0 Winstone 96 units on a category suite, it's five times faster at 
executing that category suite than the base machine. Likewise, if a PC scores 0.5 on a category suite, 
that machine is half as fast as the base machine at executing that suite.



The units Winstone 96 uses
Winstone 96 reports its results in arbitrary units. It's a relative score:    it's only meaningful when you 
compare it to other Winstone 96 scores. So, the score isn't pixels per second, or bytes per second, or any 
other type of measurement.

The base machine's overall score is set at 10.0 Winstone 96 units, and each of the category suites is set 
at 1.0 Winstone 96 units. Winstone 96 sets these scores this way as a basis for comparison.

Just remember, the base machine is a basis for understanding a PC's performance at a glance. Faster 
PCs have larger numbers than the base machine, while slower PCs have smaller numbers than the base 
machine.



Using the base machine to compare results
The base machine for Winstone 96 is a Dell® PC with a 25-MHz Intel® 486 SX CPU running Microsoft 
Windows version 3.1 in enhanced mode. The following chart provides the statistics on the base machine.

Facts about the base machine
PC Manufacturer DELL

Model NETPLEX 425s/P (25-MHz 486SX)

BIOS manufacturer Phoenix Technologies Ltd.

BIOS version 1.10 A01

Bus type ISA

DMA Controller yes

Memory 8MB

Memory management software HIMEM.SYS version 3.10

Video Super VGA (800x600, 16 colors)

Controller on motherboard

Video Manufacturer Cirrus Logic

Video BIOS CL-GD540 x 1542 x VGA BIOS version 1.20

Hard Disk 162MB

Controller type IDE

Hardware caching no

Software caching SMARTDRV.EXE version 5.0 (defaults to 512KB while running 
Windows)

Swap file for Windows 19,679KB (permanent)

Mouse Genius Mouse Systems, model: Jx mouse

LPT ports LPT1: (I/O address = 03BC)

COM ports COM1: (I/O address = 03F8), COM2: (I/O address = 02F8)

MS-DOS Version 6.2

Windows Version 3.1

Network Novell® NetWare® Shell version 3.26



Getting technical support
If you have problems with Winstone 96, you can report those problems to us using the Problem Report 
Form. You can find the Problem Report Form at the back of this handbook, at the back of the 
Understanding and Using Winstone® 96 Version 1.0 manual, and on ZD Net/CompuServe Edition in the 
ZD Benchmark forum (GO ZDBENCH).

To submit a problem report, you can:

· Post a message about the problem on the ZD Benchmark forum on ZD Net/CompuServe Edition 
(GO ZDBENCH). Access to CompuServe is available for a fee.

· Fax the form directly to Winstone 96 Technical Support (919-380-2879).

· Mail the form to us at the following address:

Ziff-Davis Benchmark Operation
1001 Aviation Parkway, Suite 400
Morrisville, North Carolina 27560

Attn.: Winstone 96 Technical Support



Requesting a benchmark
If you'd like to request copies of Winstone 96 or other Ziff-Davis benchmarks, fill out a Benchmark 
Request Form and then:

· Fax it to our dedicated benchmark request fax number (919-380-2879)

· Mail it to us at:

Ziff-Davis Benchmark Operation
1001 Aviation Parkway, Suite 400
Morrisville, North Carolina 27560

Attn.:    Distribution Coordinator



Winstone 96:    A brief definition
Winstone 96 is a benchmark that runs test suites of Windows-based applications. In developing Winstone 
96's suites, we did extensive research into which applications are leaders in today's software market. We 
also did usability surveys and tests to determine how typical users work with these applications. The 
result of this research is an accurate and repeatable benchmark you can use to determine a PC's overall 
performance when running today's top-selling Windows-based applications.

Winstone 96 doesn't mimic applications; it actually runs applications. When you choose one of Winstone 
96's test suites, it runs the application scripts associated with that suite. Each application script starts its 
application, performs tasks within that application, and exits the application. Winstone 96 times how long 
it takes each application script to complete and then computes a single, relative score for that test suite. 
You can compare a PC's score with the scores of other PCs¾higher scores mean faster overall 
performance.



Making sure a comparison is valid
Once you've run Winstone 96, you'll want to use its scores to judge a PC's performance. You should, 
however, remember a few very important details before you begin making any comparisons:

1. IMPORTANT!    You can't meaningfully compare the most current release's scores with scores 
from previous versions of Winstone. Each new version of Winstone includes substantial changes, 
and those changes affect scores. So, you should always compare scores from the same version 
of Winstone.

2. Winstone 96's scores are relative scores. A relative score is an arbitrary unit that is meaningless 
until you compare it with other similar scores. So, to understand what a Winstone 96 Unit Score 
of 40.0 means about a PC, you'll need to compare that score to Winstone 96 scores for other 
PCs. (For more details, see The units Winstone 96 uses.)

3. If you're trying to determine which of two PCs outperforms the other, keep in mind that a PC's 
hardware and software setup affects its performance. To find out about a PC's system information 
at the time you ran Winstone 96, you can view its Disclosure information (for more details, see 
Viewing Disclosure information for the current displayed scores).



Creating a custom configuration file
Winstone 96 includes a prototype configuration file, SAMPLE.CFG, in the \ZDBENCH\WB96 directory on 
the CD-ROM.

To create a custom configuration file:

1. Copy the SAMPLE.CFG file to another file name, such as CUSTOM.CFG.

2. Edit the new file so it contains the configuration information you want Winstone 96 to check. 
(Functions provides details on the list of available commands. For a few examples to use as 
guidelines when you edit the file, see Examples.)

Once you've edited and saved the custom file, you'll need to load the file during the Winstone 96 session 
for Winstone 96 to use it during its configuration check (see Custom Configuration File for more 
information).



How Winstone 96 uses a custom file
After you load a custom file, Winstone 96 compares the test PC's system configuration with the settings in 
the custom file before each test run.

To increase the speed of execution, Winstone 96 parses the custom configuration file entirely within 
memory. Thus, a custom configuration file must be less than 64KB in size.

Winstone 96 executes the custom configuration file one line at a time. The file contains five elements:    
Comments, Entry = lines, [section] lines, Functions, and Expressions.



Comments
Comments in a custom configuration file explain what each command in the file does. You enter 
comments in the file using two adjacent slashes (//) at the beginning of the line. The comment can start 
anywhere on a line and extends until the next new line. Winstone 96 treats double slashes enclosed 
within quotation marks (" ") as part of a literal string and not a comment.

Comments are for your use only; Winstone 96 ignores all text within a comment.



entry = lines
Winstone 96 uses entry = lines to retrieve information from the test PC's environment variables, the 
benchmark's disclosure fields, or the PC's .INI files. You can specify where the entry = line looks for 
information by using the #focus( ) function (see focus(FOCUS)).

All entry = lines have the following general syntax:

entry = [FormatString,] VariableList

Where:

· entry is the name of the environment variable, disclosure field, or .INI file entry whose value you 
want to retrieve. Winstone 96 scans the value of entry as a series of input fields.

· FormatString defines a format specifier (similar to the C sscanf( ) function).

The FormatString option recognizes three format specifiers:    %d, %f, and %s. With these three 
format specifiers the parser can format integers (from -2,147,483,684 to 2,147,483,687), floating 
point numbers (from 1.7 x 10-308 to 1.7 x 10308), and strings.

You don't have to specify a FormatString option. If the FormatString is missing, Winstone 96 
stores the contents of entry in the one variable you specify. This is useful for reading entire 
strings, rather than formatting them one token at a time.

· VariableList defines where you want Winstone 96 to store the formatted input.

The VariableList option can contain up to 32 variables, separated by commas. Variable names 
must be unique within the first 31 characters and must follow C rules for naming variables.

Variables are only valid until the next entry = line. The VariableList for each entry = line replaces 
the VariableList from the previous entry = line.



[section] lines
A [section] line specifies the section Winstone 96 uses when retrieving entries from an .INI file. You can 
use [section] lines only if the current focus is an .INI file; otherwise, Winstone 96 will issue an error 
message because it cannot find the .INI file. You can set the focus using the #focus( ) function (see 
focus(FOCUS)).



Functions
if(expression)

else

endif

focus(FOCUS)

text(FormatString[,VariableList])

note(FormatString[,VariableList])

notify(void)



if(expression)
You can use the #if(expression) function to check if certain conditions exist on the test PC. You can use 
the following BOOL operators in the #if function:

&& numbers only
|| numbers only
== numbers and strings
!= numbers and strings
in strings only
< numbers and strings
<= numbers and strings
> numbers and strings
>= numbers and strings

For information on variables you can use in the (expression) see Expressions.



else
The #else function tells the benchmark what to do if the #if function is not true. The #else function is 
optional.



endif
The #endif function marks the end of the #if function.



focus(FOCUS)
The #focus(FOCUS) function sets the system location where the benchmark retrieves configuration 
information.

Valid values for FOCUS are:

Disclosure benchmark disclosure fields
Environment environment variables
inifile .INI file name



text(FormatString[,VariableList])
The #text(FormatString[,VariableList]) function overrides the default text for the previous entry = line. 
Winstone 96 displays this text in the top portion of the Configuration Information window. The syntax rules 
for this function are the same as the C printf( ) function except that %d, %f, and %s are the only 
allowable format specifiers.



note(FormatString[,VariableList])
The #note(FormatString[,VariableList]) function links a note to the previous entry = line. Winstone 96 
displays this note in the Note section of the Configuration Information window when the tester selects the 
corresponding text message in top portion of that window.

The syntax rules for this function are the same as the C printf( ) function except that %d, %f, and %s are 
the only allowable format specifiers.



notify(void)
The #notify(void) function notifies the benchmark of a conflict. When the benchmark receives a #notify 
function, it displays either a default text message or text specified in the #text function in the 
Configuration Information window. If the tester supplies a note, the benchmark displays this note in the 
Note text box.



Expressions
The general syntax for an expression is:

A operator B

A and B can be any of the following:

A variable name.

A string or numeric constant.

One of the following pre-defined constants:

TRUE 1
FALSE 0
WIN16 TRUE if OS is 16-bit Windows.
WFWG TRUE if OS is Windows for Workgroups.
WIN95 TRUE if OS is Windows 95.
DISKSPACE Amount of free space on the working drive.
FREEMEM Amount of free memory.
SYSTEMRAM Amount of processor RAM.

· Another expression.

The operator can be any one of the following:

< less than
<= less than or equal to
> greater than
>= greater than or equal to
== equal to
!= not equal to
&& logical AND
|| logical OR
in tests if A is a substring of B



Examples
This section provides examples you can build upon for a custom configuration file (see the SAMPLE.CFG 
file in the \ZDBENCH\WB96 directory).

Related Topics:
Checking DOS environment variables

Checking entries in WIN.INI

Checking entries in SYSTEM.INI



Checking DOS environment variables
If you want Winstone 96's system to check to verify DOS environment variables before it runs a test, 
you'd use settings similar to the following in the custom configuration file. (Lines beginning with double 
slashes, "//," are comment lines.)

// Set the focus to the DOS environment variables.
#focus(Environment)
// Read the "TEMP" variable as a string and store the value
// in ENVVAR.
TEMP = envvar
// If ENVVAR is empty, set NOTE and call NOTIFY to update 
// the Configuration Information Window.
#if (envvar != "")
#else

#note("You need to set the TEMP environment variable in the 
AUTOEXEC.BAT file. For example, 'TEMP=C:\DOS'."

#notify()
#endif



Checking entries in WIN.INI
If you want Winstone 96's system to check to verify entries in the PC's WIN.INI file before it runs a test, 
you'd use settings similar to the following in the custom configuration file. (Lines beginning with double 
slashes, "//," are comment lines.)

// Set the focus to the WIN.INI file.
#focus("win.ini")
// Set the topic to the [windows] section of the WIN.INI
// file.
[windows]
// Read the "run" entry in the [windows] section as a 
// string and store the value in RUNVAR.
run = runvar
// If RUNVAR is not empty, set NOTE and call NOTIFY to 
// update the Configuration Information Window.
#if (runvar != "")

#note ("The 'run =' line in the WIN.INI file should be empty.")
#notify()

#endif
// Read the "load" entry in the [windows] section as a 
// string and store the value in LOADVAR.
load = loadvar
// If LOADVAR is not empty, set NOTE and call NOTIFY to 
// update the Configuration Information Window.
#if (loadvar != "")

#note ("The 'load =' line in the WIN.INI file should be empty.")
#notify()

#endif



Checking entries in SYSTEM.INI
If you want Winstone 96's system to check to verify entries in the PC's SYSTEM.INI file before it runs a 
test, you'd use settings similar to the following in the custom configuration file. (Lines beginning with 
double slashes, "//," are comment lines.)

// Set the focus to the SYSTEM.INI file.
#focus("system.ini")
// Set the topic to the [boot] section of the SYSTEM.INI 
// file.
[boot]
// Read the "shell" entry in the [boot] section as a string 
//and store the value in SHELLVAR.
shell = "%s", shellvar
// If SHELLVAR is not equal to "PROGMAN.EXE", set NOTE and 
// call NOTIFY.
#if (shellvar != "progman.exe")

#note("We've only tested Winstone 96 on systems running Windows 
PROGMAN.EXE as the shell program.")

#notify()
#endif



Benchmark Request Form
Please check the boxes of the products you want:

___PC Benchmarks CD-ROM containing Winstone® and WinBench® for desktop PCs running 
Windows®.

___Server Benchmarks CD-ROM containing NetBench® for file servers and ServerBench® for 
client/servers (for x86-compatible processors).

___Macintosh Benchmark CD-ROM containing MacBench® for Mac™ OS Systems.

Please send these products to:

Name: ______________________________________________________________________________

Company: ___________________________________________________________________________

Address: ____________________________________________________________________________

City: _____________________________________ State: ______________________ Zip: ___________

Country: ____________________________________________________________________________

Telephone: __________________________________ FAX: ___________________________________

We answer requests in the order we receive them. We ship all benchmarks via 3rd-class U.S. Please 
allow 4-6 weeks for delivery. For faster shipment, provide your Federal Express account information 
below:

Your Federal Express account number: ____________________________________________________

Check one: ___ priority overnight ___ standard overnight

Please return this form:
Fax to: (919) 380-2879

or Mail to: Ziff-Davis Benchmark Operation
1001 Aviation Parkway, Suite 400
Morrisville, NC 27560



Problem Report Form
Information about you:

Name: 
_________________________________________________________________________________

Address: 
_______________________________________________________________________________

Company: 
______________________________________________________________________________

E-mail address: 
__________________________________________________________________________

Phone: 
________________________________________________________________________________

Fax: 
___________________________________________________________________________________

Benchmark you're using: 
__________________________________________________________________

A description of the PC:

Example: WXY Corp. Model 486DX-66 with 8MB of RAM, 64 KB RAM cache, 200MB hard disk, IDE 
controller, no hardware disk cache, running Windows 3.1 and DOS 6.0

____________________________________________________________________________________
____________________________________________________________________________________
____________________________________________________________________________________
____________________________________________________________________________________
____________

Details of the problem:

What is the problem, and what did the benchmark do just before the problem occurred? 
_________________
____________________________________________________________________________________
____________________________________________________________________________________
____________________________________________________________________________________
_________

What message was in the status bar at the bottom of the benchmark's main window 
____________________
____________________________________________________________________________________
___

Can you reproduce the problem? ______

Could you please attach the contents of the benchmark's Disclosure and the ERRORS.TXT file? (You can 
find the ERRORS.TXT file in the benchmark's main directory.)

Other comments: 
________________________________________________________________________
____________________________________________________________________________________
____________________________________________________________________________________



____________________________________________________________________________________
________________________________________________________________________________

Please return this form:

Fax to: (919) 380-2879

or Mail to: Ziff-Davis Benchmark Operation
1001 Aviation Parkway, Suite 400
Morrisville, NC 27560




